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1. ⁄vod

Pokud jste se rozhodli pro p¯echod z n·vrhovÈho systÈmu CadSoft Eagle do prost¯edÌ Altium Designer
(AD)  a  pot¯ebujete  pokraËovat  ve  sv˝ch  jiû  osvÏdËen˝ch  projektech,  tak  bychom v·m  r·di  poskytli
pomoc v podobÏ tohoto manu·lu pro p¯evod projektu do form·tu Altium Designeru. Altium Designer

m· öirokÈ moûnosti importov·nÌ projekt˘ z jin˝ch n·vrhov˝ch prost¯edÌ, CadSoft Eagle mezi nÏ bohuûel nepat¯Ì.
NicmÈnÏ existuje postup, kter˝m vytvo¯Ìte soubory zpracovatelnÈ Altium Designerem. 

Tento postup umoûÚuje konvertovat schÈmatick˝ v˝kres a v˝kres ploönÈho spoje (PCB) s jist˝mi omezenÌmi, ale
v˝sledkem  je  plnohodnotn˝  projekt  se  vöemi  moûnostmi  pokroËilÈho  n·vrhu  elektronick˝ch  v˝robk˘.  V
souËasnÈ dobÏ nelze spolehlivÏ konvertovat polygony uvedenÈ na ploönÈm spoji a volnÏ umÌstÏnÈ vodiËe ve
schÈmatickÈm  v˝kresu.  Tato  omezenÌ  se  pokouöÌme  odstranit.  Aktu·lnÌ  informace  naleznete  na  naöich
str·nk·ch www.edatools.cz.

2. Postup

Konverze  probÌh· exportem projektu ze systÈmu Eagle  za pomoci  ULP skript˘,  kterÈ vytvo¯Ì  soubor
schÈmatu a soubor ploönÈho spoje ve form·tu Protel, kterÈ dok·ûe Altium Designer importovat.  Pro
nekomerËnÌ ˙Ëely lze ke konverzi pouûÌt volnÏ a bezplatnÏ dostupnou verzi Eaglu, kter· m· omezenÌ

pouze v editaci PCB. Prov·dÏnÌ export˘ se toto omezenÌ net˝k·. 

Skripty jsou dostupnÈ oddÏlenÏ na str·nk·ch spoleËnosti CadSoft (www.cadsoft.de) v sekci Download -> ULPs
pod jmÈny:

eagle2ad_sch.ulp  (autor Christian Keller) ñ konverze schÈmatu do form·tu Altium/Protel
export-protelpcb.ulp (autor Alex Galakhov) ñ konverze PCB do form·tu Protel

Tyto skripty jsou dod·v·ny bez garance funkËnosti a bez ruËenÌ za zp˘sobenÈ chyby. Konverzi prov·dÏjte
na kopiÌch  projektov˝ch  soubor˘ v oddÏlenÈm adres·¯i  a  po konverzi  proveÔte  d˘kladnou  kontrolu
konvertovan˝ch dat ñ zda jsou p¯evedeny vöechny komponenty a jejich vz·jemn· elektrick· propojenÌ.
Pro  konverzi  pouûÌvejte  pouze  plnÏ  funkËnÌ  dokumenty  s  bezproblÈmovou  konzistencÌ  dat  mezi
schÈmatick˝m v˝kresem a v˝kresem ploönÈho spoje.

Postup konverze je demonstrov·n na vyd·nÌ Altium Designer Summer 09 (verze 9.4.0.20159) a Eagle 5.10.0 ve
verzi Light.

2.1. Export dat z programu Eagle

Export dat z programu Eagle probÌh· oddÏlenÏ ve schÈmatickÈm editoru a v editoru ploönÈho spoje.
P¯ed provedenÌm tohoto kroku je vhodnÈ provÈst nÏkterÈ ˙pravy zdrojov˝ch dokument˘ tak, aby bylo
dosaûeno plnohodnotnÈho p¯evodu vöech dat.
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2.1.1. Export schÈmatickÈho v˝kresu

Jako prvnÌ krok provedeme p¯evedenÌ souboru se schÈmatem. Do schÈmatickÈho editoru naËteme schÈmatick˝
v˝kres. Pro ˙spÏönou konverzi je nutnÈ splnit nÏkolik poûadavk˘:

• v˝kres se musÌ nach·zet v prvnÌm kvadrantu sou¯adnicovÈho systÈmu (kladnÈ hodnoty sou¯adnic)

• nesmÌ obsahovat volnÏ poloûenÈ vodiËe (bez elektrickÈho propojenÌ)

Pro provedenÌ tÏchto ˙prav jste p¯ipraveni provÈst konverzi. Z menu File vyberete poloûku Run... nebo kliknÏte
na ikonu viz  n·sledujÌcÌ  obr·zek.  Zadejte  cestu ke skriptu s n·zvem  eagle2ad_sch.ulp a  zvolte  Open.  Po
aktivaci tohoto skriptu jste vyzv·ni k v˝bÏru mÌsta, kam bude uloûen konvertovan˝ schÈmatick˝ v˝kres. Skript
postupnÏ p¯ev·dÌ jednotlivÈ str·nky v˝kresu do oddÏlen˝ch soubor˘ s n·zvem rozöÌ¯en˝m o index str·nky a
p¯Ìponou SchDoc. PotÈ jste informov·ni o ˙spÏönÈm dokonËenÌ konverze. 

Pro dosaûenÌ modifikacÌ skriptu podle vaöich poûadavk˘ prosÌm prostudujte n·povÏdu programu Eagle v sekci
User Language. V p¯ÌpadÏ ne˙spÏönÈ konverze se obracejte na technickou podporu uvedenou v kapitole 5.2.

2.1.2. Export v˝kres˘ ploönÈho spoje

Jak  jiû  bylo  uvedeno,  skript  pro export  ploönÈho spoje  v  souËasnÈ  dobÏ neumoûÚuje  p¯enÈst  informace  o
objektech typu polygon. Tyto musÌ b˝t do zkonvertovanÈho v˝kresu ploönÈho spoje doplnÏny ruËnÏ aû v Altium
Designeru, jak bude pops·no v kapitole 2.2.3. P¯ed vlastnÌ konverzÌ je nutnÈ provÈst tyto ˙pravy:

• vöechny objekty na v˝kresu musÌ b˝t umÌstÏny v prvnÌm kvadrantu sou¯adnicovÈho systÈmu (kladnÈ
hodnoty sou¯adnic)

• p¯ed exportem provÈst p¯Ìkaz  SMASH pro vöechny komponenty ñ vybrerte vöechny objekty pomocÌ
p¯Ìkazu GROUP a n·slednÏ p¯Ìkazem SMASH a kombinacÌ kl·vesy Ctrl a kliknutÌ na pravÈ tlaËÌtko myöi
oddÏlÌte popisky komponent od jejich hlavnÌ Ë·st ñ footprintu

ExportnÌ skript  export-protelpcb.ulp obsahuje ke konci svÈho zdrojovÈho textu Ë·st pro p¯i¯azenÌ  vrstev z
Eaglu do vrstev Altium Designeru, viz n·sledujÌcÌ  uk·zka. VÏnujte prosÌm plnou pozornost tomuto p¯i¯azenÌ
vrstev. Program Eagle i Altium Designer umoûÚujÌ  v nÏkter˝ch p¯Ìpadech uûivatelskÈ vyuûitÌ  vrstev, kterÈ je
nutnÈ sjednotit pr·vÏ v tÈto Ë·sti skriptu, aby konvertovan˝ soubor obsahoval veökerÈ pot¯ebnÈ informace v
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odpovÌdajÌcÌch vrstv·ch. DodateËnÈ ˙pravy po konverzi jsou ËasovÏ n·roËnÈ a lze jim vhodn˝m nastavenÌm
p¯i¯azenÌ vrstev p¯edejÌt.

Uk·zkovÈ p¯i¯azenÌ vrstev pro oboustrann˝ ploön˝ spoj bez vnit¯nÌch vrstev:

EAGLE Altium Designer

layer [LAYER_TOP]       = "TOP";  

layer [LAYER_BOTTOM]    = "BOTTOM";

layer [LAYER_PADS]      = "MULTILAYER"; //?

layer [LAYER_VIAS]      = "MULTILAYER"; //?

layer [LAYER_UNROUTED]  = "bug"; //!

layer [LAYER_DIMENSION] = "KEEPOUT";

layer [LAYER_TPLACE]    = "TOPOVERLAY";

layer [LAYER_BPLACE]    = "BOTTOMOVERLAY";

layer [LAYER_TORIGINS]  = "";

layer [LAYER_BORIGINS]  = "";

layer [LAYER_TNAMES]    = "TOPOVERLAY";

layer [LAYER_BNAMES]    = "BOTTOMOVERLAY";

layer [LAYER_TVALUES]   = "MECHANICAL3";

layer [LAYER_BVALUES]   = "MECHANICAL4";

layer [LAYER_TSTOP]     = "";

layer [LAYER_BSTOP]     = "";

layer [LAYER_TCREAM]    = "TOPPASTE";

layer [LAYER_BCREAM]    = "BOTTOMPASTE";

layer [LAYER_TFINISH]   = "";

layer [LAYER_BFINISH]   = "";

layer [LAYER_TGLUE]     = "MECHANICAL8";

layer [LAYER_BGLUE]     = "MECHANICAL9";

layer [LAYER_TTEST]     = "TOPOVERLAY";

layer [LAYER_BTEST]     = "BOTTOMOVERLAY";

layer [LAYER_TKEEPOUT]  = "MECHANICAL12";

layer [LAYER_BKEEPOUT]  = "MECHANICAL13";

layer [LAYER_TRESTRICT] = "MECHANICAL12";

layer [LAYER_BRESTRICT] = "MECHANICAL13";

layer [LAYER_VRESTRICT] = "MECHANICAL14";

layer [LAYER_DRILLS]    = "MULTILAYER";

layer [LAYER_HOLES]     = "MULTILAYER";

layer [LAYER_MILLING]   = "MECHANICAL1"; 

layer [LAYER_MEASURES]  = "MECHANICAL2"; //?

layer [LAYER_DOCUMENT]  = "MECHANICAL2"; //?

layer [LAYER_REFERENCE] = "MECHANICAL2"; //?

layer [LAYER_TDOCU]     = "TOPOVERLAY";

layer [LAYER_BDOCU]     = "BOTTOMOVERLAY";

Pro provedenÌ tÏchto ˙prav jste p¯ipraveni provÈst konverzi. Z menu File vyberete, stejnÏ jako ve schÈmatickÈm
editoru, poloûku Run... nebo kliknÏte na ikonu ULP v hornÌm menu. Zadejte cestu ke skriptu s n·zvem export-
protelpcb.ulp a  zvolte  Open.  Po  aktivaci  tohoto  skriptu  jste  vyzv·ni  k  v˝bÏru  mÌsta,  kam  bude  uloûen
konvertovan˝  schÈmatick˝  v˝kres.  Skript  p¯evede  v˝kres  do  jednotho  soubor  s  p¯Ìponou  pcb.  PotÈ  jste
informov·ni o ˙spÏönÈm dokonËenÌ konverze.

Pro dosaûenÌ modifikacÌ skriptu podle vaöich poûadavk˘ prosÌm prostudujte n·povÏdu programu Eagle v sekci
User Language. V p¯ÌpadÏ ne˙spÏönÈ konverze se obracejte na technickou podporu uvedenou v kapitole 5.2.
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2.2. Vytvo¯enÌ projektu v Altium Designeru

ExportovacÌ skripty vytv·¯ejÌ soubory ve form·tu Altium nebo Protel, kter˝ lze p¯Ìmo pouûÌt v Altium
Designeru. Za ˙Ëelem plnÈho vyuûitÌ moûnostÌ Altium Designeru se nicmÈnÏ doporuËuje uloûit soubory
znovu v aktu·lnÌ verzi form·tu dokument˘ a provÈst nÏkterÈ dalöÌ kroky pro dosaûenÌ plnohodnotnÈho

p¯evodu projektu. Tyto kroky jsou pops·ny v n·sledujÌcÌch podkapitol·ch.

2.2.1. NastavenÌ projektu

Altium Designer podporuje nÏkolik druh˘ projekt˘. Pro konverzi n·vrhu z programu Eagle je vhodn˝ projekt
typu PCB, kter˝  vytvo¯Ìte v  menu  File ->  New ->  Project ->  PCB Project.  V tuto chvÌli  p¯i¯adÌme do novÏ
vzniklÈho projektu pomocÌ p¯Ìkazu  Project ->  Add Existing to Project... soubory s koncovkou  SchDoc a  pcb
vytvo¯enÈ v kapitol·ch 2.1.1 a 2.1.2.

V takto vytvo¯enÈm projektu je vhodnÈ upravit  nastavenÌ  Project ->  Project  Options... tak,  aby  odpovÌdalo
vlastnostem  projekt˘  v  Eaglu.  V  z·loûce  Options  tedy  zmÏÚte  nastavenÌ  Net  Identifier  Scope na  Global
(Netlabels and ports global) a v z·loûce Class Generation je takÈ vhodnÈ zruöit zaökrtnutÌ Generate Rooms u
vöech schÈmatick˝ch soubor˘, viz n·sledujÌcÌ obr·zky. OstatnÌ nastavenÌ mohou b˝t ponech·na v z·kladnÌch
hodnot·ch. Projekt uloûte, viz kapitola 2.3.3.
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2.2.2. Import schÈmatick˝ch v˝kres˘

Otev¯ete dokument schÈmatickÈho v˝kresu z panelu Projects a zkontrolujte stav zkonvertovanÈho dokumentu ñ
zda jsou obsaûeny vöechny  komponenty  a spoje.  Komponenty  v  programu Eagle  jsou tvo¯eny z  Ëar,  ne  z
objekt˘, proto nemajÌ po konverzi vyplnÏnou vnit¯nÌ plochu jak je u Altium Designeru zvykem. Pro dosaûenÌ
tohoto stavu je nutnÈ ruËnÏ p¯edÏlat komponenty v knihovnÏ. Pr·ce s knihovnou je pops·na v kapitole 2.3.2.
BÏhem konverze m˘ûe dojÌt k oddÏlenÌ prvk˘ typu Net Label od p¯Ìsluön˝ch vodiË˘. O tomto jste upozornÏnÌ v
panelu  Messages bÏhem kompilace projektu (Project ->  Compile PCB Project Ñn·zevì.PrjPCB). Pro dosaûenÌ
lepöÌho  vzhledu  schÈmatu  m˘ûete  nastavit  typick˝  form·t  v˝kresu  a jeho  r·meËek v  Design ->  Document
Options...

DoporuËenou ruËnÌ ˙pravou je nahrazenÌ nap·jecÌch symbol˘. Na rozdÌl od Eaglu Altium Designer pouûÌv· pro
nap·jecÌ symboly specializovanÈ komponenty, kterÈ naleznete v hornÌ Ë·sti menu schÈmatickÈho editoru AD
(viz p¯edchozÌ obr·zek).  Tyto symboly lze zmÏnit graficky (kl·vesa  Tab bÏhem umisùov·nÌ) a lze jim p¯idÏlit
libovolnÈ jmÈno (podle p˘vodnÌho symbolu v Eaglu). TÌmto nahrazenÌm p¯edejdete nekompatibilitÏ projektu s
nÏkter˝mi n·stroji  a umoûnÌte tak plnohodnotnou synchronizaci dokument˘ projektu. Pokud je ruËnÌ ˙prava
n·roËn·, tak lze provÈst hromadnou ˙pravu st·vajÌcÌch symbol˘, kdy  pomocÌ funkce Find Similar ObjectsÖ v
kontextovÈm menu vyhled·te vöechny komponenty z knihoven SUPPLY1 a 2, kterÈ se v programu Eagle bÏûnÏ
pouûÌvajÌ  pro nap·jecÌ symboly. Parametr  Component Type tÏchto komponent pak zmÏÚte  pomocÌ n·stroje
SCH Inspector na hodnotu Graphical. Po tÈto zmÏnÏ se AItium Designer nebude snaûit vyhledat jejich p¯edlohu
pro  ploön˝  spoj  a  budou  odstranÏny  i  z  v˝slednÈ  soupisky  osazovanÈho  materi·lu.  Nejedn·  se  vöak  o
plnohodnotnÈ  nap·jecÌ  symboly  nap¯Ìklad  pro  ˙Ëely  simulace.  Stejnou  zmÏnu  typu  komponenty  je  nutnÈ
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provÈst i u p¯ÌpadnÈho r·meËku nebo razÌtka v˝kresu. Podrobnosti o typech komponent naleznete v manu·lu
TR0111.

DalöÌ manu·lnÌ ˙pravy jsou zpravidla vyûadov·ny pro dosaûenÌ graficky vhodnÈho umÌstÏnÌ a velikosti popisk˘
komponent a spoj˘. Jedn· se o kosmetickou ˙pravu bez p¯ÌmÈho vlivu na funkci celÈho projektu. V nÏkter˝ch
p¯Ìladech doch·zÌ k automatickÈmu spojenÌ k¯ÌûÌcÌch se vodiË˘ doplnÏnÌm uzlu (junction). Typicky se jedn· o
k¯ÌûenÌ sign·lu se sbÏrnicÌ v mÌstÏ odboËky. V takovÈm p¯ÌpadÏ odsuÚte spoj z mÌsta k¯ÌûenÌ.

V p¯ÌpadÏ ne˙spÏönÈ konverze se obracejte na technickou podporu uvedenou v kapitole 5.2.

2.2.3. Import ploön˝ch spoj˘

Otev¯ete dokument ploönÈho spoje z panelu  Projects. Import ploönÈho spoje probÌh· po otev¯enÌ dokumentu
pomocÌ automaticky spuötÏnÈho pr˘vodce DXP Import Wizard. V prvnÌm kroku zvolte, z kterÈ vrstvy a objektu
m· b˝t vytvo¯eno ohraniËenÌ ploönÈho spoje. Obvykle staËÌ ponechat p¯edvolenou moûnost Define Board Shape
from bounding rectangle. V dalöÌm kroku jste poû·d·ni o nastavenÌ konverze n·vrhov˝ch pravidel, kter· ovöem
program Eagle  nepodporuje,  takûe  tento krok je  bez moûnosti  nastavenÌ  a efektu na  v˝sledn˝  dokument.
PoslednÌ krok pr˘vodce se t˝k· nastavenÌ vnit¯nÌch nap·jecÌch vrstev, kterÈ program Eagle rovnÏû nepodporuje.
Pr˘vodce ukonËete tlaËÌtkem Finish. 

Ploön˝ spoj je po ˙spÏönÈm ukonËenÌ pr˘vodce automaticky zobrazen. Zkontrolujte, zda konverze probÏhla v
po¯·dku a zda ploön˝ spoj obsahuje vöechny poûadovanÈ komponenty v pot¯ebn˝ch vrstv·ch. Pokud zjistÌte
chybu v p¯i¯azenÌ vrstev, tak proveÔte export dat z programu Eagle znova s upraven˝m p¯i¯azenÌm vrstev podle
kapitoly 2.1.2. Obvykle je nutnÈ mÌrnÏ upravit velikost a zrcadlenÌ textov˝ch ¯etÏzc˘. Do v˝kresu ploönÈho spoje
doplÚte ruËnÏ polygony s rozlitÌm mÏdi p¯Ìkazem Place -> Polygon PourÖ podle zdrojov˝ch dokument˘ vËetnÏ
p¯ipojenÌ  na konkrÈtnÌ  sign·l  (Net).  NastavenÌ  izolaËnÌ  mezery  nebo stylu  p¯ipojenÌ  polygonu  k  pad˘m lze
nastavit pomocÌ spr·vce polygon˘ viz  Tools ->  Polygon Pours ->  Polygon Manager. V tomto spr·vci vyberte
poûadovan˝  polygon  jemuû  chcete  p¯i¯adit  nastavenÌ  a  k  provedenÌ  tÈto  ˙pravy  pouûijte  tlaËÌtka  Create
Clearance Rule... a  Create Polygon Connect Style Rule... Tato tlaËÌtka vytvo¯Ì pot¯ebn· n·vrhov· pravidla pro
konkrÈtnÌ polygon.  DetailnÌ informace o pr·ci  s  polygony naleznete  v n·povÏdÏ v dokumentu s oznaËenÌm
AP0101.

Pro korektnÌ fungov·nÌ ploönÈho spoje je pot¯ebnÈ nastavit n·vrhov· pravidla alespoÚ pro rozmÏr dÏr, z·kladnÌ
izolaËnÌ  vzd·lenost  a  öÌ¯ku  spoj˘.  Tato  pravidla  naleznete  v  nabÌdce  Design ->  Rules v  kategoriÌch
Manufacturing -> Hole Size,  Electrical -> Clearance a Routing -> Width. RovnÏû je vhodnÈ provÈst nastavenÌ
ostatnÌch pravidel v kategorii  Manufacturing, kter· definujÌ parametry  potisku (Silkscreen) a nep·jivÈ masky
(Mask). Pro podrobnÏjöÌ pr·ci s n·vrhov˝mi pravidly si prostudujte dokumenty n·povÏdy s oznaËenÌm AR0111 a
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TR0116. Po nastavenÌ pravidel m˘ûete provÈst kontrolu v˝kresu ploönÈho spoje p¯Ìkazem Tools -> Design Rules
Check...

V p¯ÌpadÏ ne˙spÏönÈ konverze se obracejte na technickou podporu uvedenou v kapitole 5.2.

2.3. DokonËenÌ projektu v Altium Designeru

Pro moûnost vyuûitÌ vöech pokroËil˝ch n·stroj˘ Altium Designeru je nutnÈ provÈst jeötÏ nÏkolik ˙prav v
r·mci projektu, kterÈ zajistÌ plnÈ prov·z·nÌ schÈmatickÈho v˝kresu a v˝kresu ploönÈho spoje. 

2.3.1. Synchonizace dokument˘ v projektu

Po ukonËenÌ importu dokument˘ provedeme jejich uloûenÌ vËetnÏ uloûenÌ vlastnÌho projektu. Altium Designer
se v tomto p¯ÌpadÏ bude dom·hat nastavenÌ form·tu soubor˘ na aktu·lnÌ verzi (s nejvyööÌm ËÌslem). Soubory
poch·zejÌcÌ z konverznÌch skript˘ jsou totiû uloûeny ve form·tu pro program Protel. P¯evod form·tu na aktu·lni
verzi m˘ûete potvrdit.

Komponenty  v  AD  vyuûÌvajÌ  k  identifikaci  unik·tnÌ  ID  ¯etÏzec  podle  kterÈho  lze  komponenty  vz·jemnÏ
identifikovat  v  r˘zn˝ch  editorech  i  kdyû  dojde  ke  zmÏnÏ  popisku  (Designator)  nebo  dalöÌch  parametr˘.  V
aktu·lnÌm stavu nejsou komponenty vybaveny tÌmto ¯etÏzcem. Ve schÈmatickÈm editoru proto zvolte Tools ->
Convert -> Reset Component Unique IDs... a vyberte moûnost All schematic documents in the current project.

V editoru ploönÈho spoje aktivujte p¯Ìkaz Design -> Netlist -> Clear All Nets..., kter˝ z PCB dokumentu odstranÌ
logickÈ propojenÌ vöech elektrick˝ch spoj˘ a existujÌcÌ fyzickÈ spoje tak budou  oznaËeny jako chybnÈ (Violation
ñ  Short Circuit) nastavenou zv˝razÚujÌcÌ  barvou a vzorem. NynÌ rovnÏû v editoru ploön˝ch spoj˘ aktivujeme
n·stroj Project -> Component Links... V tomto n·stroji nastavujeme jakÈ komponenty ve schÈmatickÈm v˝kresu
odpovÌdajÌ kter˝m komponent·m na ploönÈm spoji. Pokud byl p¯ev·dÏn plnÏ funkËnÌ projekt z programu Eagle
se  zachovanou  konzistencÌ  dat,  tak  jsou  u  odpovÌdajÌcÌch  komponent  shodn·  pole  popisk˘  neboli  pole
Designator.  DÌky  tomu  m˘ûeme  v  n·stroji  Component  Links pouûÌt  tlaËÌtko  Add  Pairs  Matched  By se
zaökrtnut˝m  parametrem  Designator a  p¯i¯azenÌ  komponent  probÏhne  automaticky.  P¯ÌpadnÈ  konflikty  lze
vy¯eöit manu·lnÏ. ZmÏny potvrdÌme tlaËÌtkem Perform Update.

Po tomto p¯i¯azenÌ komponent m˘ûeme p¯istoupit k vlastnÌ synchronizaci obou dokument˘. Ve schÈmatickÈm
editoru pouûÌjte funkci Design -> Update PCB Document nebo v editoru ploön˝ch spoj˘ jejÌ ekvivalent Design ->
Import Changes From Ñn·zevì.PrjPCB.  Po provedenÌ porovn·nÌ dokument˘ se zobrazÌ  formul·¯  Engineering
Change Order, ve kterÈm naleznete veökerÈ navrhovanÈ zmÏny dokument˘, aby bylo dosaûeno synchronnÌho
stavu. Obvykle se zmÏny t˝kajÌ hodnot parametr˘ komponent (pojmenov·nÌ footprintu, n·zev knihovny atd.) a
takÈ p¯id·nÌ elektrickÈho propojenÌ komponent kv˘li odstranÏnÈmu netlistu v jednom z p¯edchozÌch krok˘. Tyto
zmÏny jsou obvykle û·doucÌ, ale i p¯esto proveÔte jejich podrobnou kontrolu. BuÔte velice opatrnÌ p¯edevöÌm u
zmÏn typu  Remove, kdy je navrhov·no odstranÏnÌ komponent, kterÈ jsou na ploönÈm spoji, ale nemajÌ sv˘j
symbol ve schÈmatickÈm v˝kresu apod. Pokud veökerÈ zmÏny probÏhly ˙spÏönÏ, tak spusùte funkci  Update  /
Import znovu. MÏli byste obdrûet zpr·vu No Differences Detected. V tomto stavu jsou dokumenty kompletnÏ
synchronizov·ny.  Podrobn˝  popis  procesu  synchronizace  naleznete  v  n·povÏdÏ  v  dokumentu  s  oznaËenÌm
AR0106.
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2.3.2. ⁄pravy knihoven

Konverze projektu si Ëasto vyû·d· menöÌ ˙pravy prvk˘ (typicky potisk), kterÈ je vhodnÈ prov·dÏt na ˙rovni
knihoven. Za tÌmto ˙Ëelem vytvo¯Ìme integrovanou knihovnu projektu v libovolnÈm dokumentu pomocÌ p¯Ìkazu
Design -> Make Integrated Library. Tento p¯Ìkaz vyhled· vöechny unik·tnÌ komponenty v projektu a zahrne je
do projektovÈ knihovny. U nÏkter˝ch komponent jste vyzv·ni k rozhodnutÌ, zda chcete zahrnout do knihovny
pouze jednu verzi komponenty, ne jeji parci·lnÌ modifikace (jinÈ parametry, pozice popisk˘ atd.). Tato volba je
optim·lnÌ  pro redukci  poËtu komponent  v  knihovnÏ  na rozumnou mÌru  pro efektivnÌ  spravov·nÌ  knihovny.
Knihovna  je  automaticky  p¯id·na  do  vaöeho  PCB projektu  a  do  seznamu instalovan˝ch  knihoven,  ËÌmû  je
dostupn· pro dalöÌ p¯id·v·nÌ komponent.

Aby bylo dosaûeno moûnosti jednoduchÈ aktualizace ˙prav z vytvo¯enÈ integrovanÈ knihovny, tak je nutnÈ ve
schÈmatickÈm vykresu vybrat vöechny komponenty a pomocÌ n·stroje  SCH Inspector zmÏnit parametr  Library
Name na n·zev souboru vytvo¯enÈ knihovny (Ñn·zev knihovnyì.IntLib). Tyto zmÏny pak pomocÌ funkce Update
p¯eveÔte do dokumentu ploönÈho spoje. 

Editace knihovny probÌh· standardnÌm zp˘sobem. Po otev¯enÌ knihovny dojde k zaloûenÌ knihovnÌho projektu,
do kterÈho se extrahujÌ  jednotlivÈ  knihovny se schÈmatick˝mi symboly  a s  footprinty  pro ploön˝  spoj.  Zde
m˘ûeme prov·dÏt libovolnÈ ˙pravy. Po dokonËenÌ ˙prav je nutnÈ knihovnÌ projekt zkompilovat, ËÌmû vznikne v
jeho adres·¯i nov· sloûka Project Outputs a v nÌ aktualizovan· integrovan· knihovna. Tuto knihovnu je nutnÈ
p¯enÈst  na  mÌsto  p˘vodnÌ  automaticky  vytvo¯enÈ  integrovanÈ  knihovny.  NynÌ  budou  n·stroje  Footprint
Manager,  Update From Library a Update From PCB Library mÌt p¯Ìstup k aktu·lnÌm informacÌm pro provedenÌ
poûadovan˝ch zmÏn. NÏkterÈ z tÏchto n·stroj˘ vyûadujÌ p¯ed aktivacÌ kompilaci PCB projektu v menu Project ->
Compile PCB Project.

2.3.3. UloûenÌ projektu

Pokud jste projekt neuloûili jiû v d¯ÌvÏjöÌ f·zi, tak to proveÔte nynÌ. P¯i ukl·d·nÌ dokument˘ budete vyzv·ni k
uloûenÌ v nejnovÏjöÌ verzi bin·rnÌch soubor˘, jak bylo uvedeno v kapitole 2.3.1, ze kter˝ch jiû nebudete muset v
budoucnu prov·dÏt import. Jedn· se o nativnÌ soubory Altium Designeru. Tuto konverzi potvrÔte. Struktura
projektu nenÌ fixnÌ, pro vÏtöÌ p¯ehlednost m˘ûete ukl·dat schematickÈ v˝kresy do dedikovanÈho podadres·¯e,
stejnÏ jako ostatnÌ dokumenty projektu.UloûenÌm je konverze projektu z programu Eagle dokonËena. VÏ¯Ìme, ûe
uveden˝  postup v·m pom˘ûe  p¯edejÌt  mnoha komplikacÌm.  N·sledujÌcÌ  kapitola  vysvÏtluje  z·klady  pr·ce s
projekty a knihovnami v Altium Designeru. Tento kr·tk˝ p¯ehled by v·m mÏl poskytnout dostateËn˝ ˙vodnÌ
p¯ehled o tÈto problematice pro lepöÌ zaË·tek pr·ce v novÈm n·vrhovÈm prostr¯edÌ.

3. Projekty a knihovny

N·vrhov˝ systÈm Altium Designer nabÌzÌ velice öirokÈ moûnosti spr·vy projekt˘ a disponuje flexibilnÌm
knihovnÌm  systÈmem.  JednotlivÈ  n·vrhy  jsou  v AD  seskupeny  do  projekt˘.  Tyto  projekty  jsou  d·le
sdruûov·ny do celk˘ oznaËovan˝ch jako workspace, kterÈ umoûÚujÌ spoleËnÏ naËÌst a ukl·dat souvisejÌcÌ

projekty (i r˘zn˝ch typ˘), nap¯. pro ploön˝ spoj a pro konfiguraci FPGA na tomto ploönÈm spoji, p¯ÌpadnÏ i dalöÌ
pomocnÈ ploönÈ spoje tvo¯ÌcÌ fyzicky celek danÈho za¯ÌzenÌ. 

Altium Designer ñ ZaËÌn·me   (5.12.2010) www.edatools.cz  |  8



3.1. Typy projekt˘

AD ËlenÌ projekty celkem do 6 typ˘ podle toho, na kterou Ëinnost jsou projekty zamÏ¯eny. Typy projekt˘ jsou
n·sledujÌcÌ:

• PCB ñ z·kladnÌ typ projektu pro n·vrh ploönÈho spoje (PCB). Takov˝to projekt obsahuje p¯edevöÌm
schematickÈ  podklady pro n·vrh ploönÈho  spoje,  soubory ploönÈho spoje,   nastavenÌ  pravidel  pro
n·vrh spoj˘, knihovny, p¯ÌpadnÏ dalöÌ soubory s dokumentacÌ atd. 

• FPGA ñ projekt zamÏ¯en˝ na n·vrh konfigurace FPGA je podobn˝ projekt˘m z n·vrhov˝ch prost¯edÌ
v˝robc˘ FPGA. UmoûÚuje tedy sdruûovat n·vrh konfigurace FPGA realizovan˝ textovÏ v podobÏ HDL
soubor˘ (VHDL a Verilog) nebo v podobÏ grafickÈho schÈmatu. Zde je pouûit stejn˝ schematick˝ editor
jako  pro  projekty  PCB.  D·le  pak  projekt  obsahuje  soubor  p¯i¯azenÌ  logick˝ch  port˘  konfigurace
k fyzick˝m v˝vod˘m FPGA (Constrain)  a takÈ v˝stupnÌ  soubory vznikajÌcÌ  syntÈzou a implementacÌ
konfigurace do konkrÈtnÌho modelu FPGA. P¯eklad probÌh· automaticky za pomoci rozhranÌ n·stroj˘
od v˝robc˘ FPGA, tudÌû jsou v˝sledky p¯Ìmo pouûitelnÈ pro konfiguraci FPGA bez jakÈkoliv konverze.
AD  navÌc  disponuje  USB-JTAG  rozhranÌm  (dod·v·no  s licencÌ  pro  AD),  kterÈ  umoûÚuje  ovl·dat
p¯ipojen˝ JTAG chain. Toto p¯ÌmÈ propojenÌ p¯in·öÌ jistÈ v˝hody, jak si uk·ûeme v nÏkterÈ p¯ÌötÌ Ë·sti
seri·lu. 

• Core ñ typ projektu smÏ¯ujÌcÌ k tvorbÏ IP jader pouûiteln˝ch pro FPGA. 

• Embedded ñ tento projekt slouûÌ k vytvo¯enÌ softwarovÈ aplikace pro procesory pouûitÈ na ploönÈm
spoji. Aplikace lze vytv·¯et pro nÏkolik typ˘ procesor˘ vËetnÏ softwarovÏ vytvo¯en˝ch procesorov˝ch
jader v FPGA, pro kterÈ je tento typ projektu prim·rnÏ urËen. 

• Integrated library ñ projekt jehoû v˝stupem je obecnÏ pouûiteln· integrovan· knihovna. SouË·stÌ
jsou knihovny schematick˝ch prvk˘ (*.SchLib),  pouzder pro ploön˝ spoj (*.PcbLib),  3D model˘ pro
ploön˝ spoj (*.Pcb3DLib), p¯ÌpadnÏ dalöÌ modely (Spice). 

• Script ñ projekt slouûÌ k v˝voji a odladÏnÌ uûivatelsky definovan˝ch funkcÌ AD. Mimo klasickÈho pojetÌ
skript˘ je moûnÈ vytvo¯it formul·¯ovou aplikaci, tak jak ji zn·me z prost¯edÌ Windows a tak p¯etvo¯it
chov·nÌ AD podle sv˝ch poûadavk˘.

3.2. Pr·ce s knihovnami

Knihovny AD se skl·dajÌ z nÏkolika Ë·stÌ.  P¯ev·ûn· Ë·st dod·van˝ch knihoven je tvo¯ena takzvan˝mi
integrovan˝mi knihovnami (*.IntLib). Takto vytvo¯en˝ soubor knihovny obsahuje vöechny pot¯ebnÈ Ë·sti
pro n·vrh a simulaci p¯i n·vrhu PCB nebo FPGA projektu. V p¯ÌpadÏ komponenty pro n·vrh ploönÈho

spoje  se  tedy  jedn· o schÈmatickou  znaËku,  2D a  3D model  pouzdra,  simulaËnÌ  model  a  logistickÈ  ˙daje
(odkazy na dokumentaci, prodejce atd.). Ne vöechny dod·vanÈ komponenty obsahujÌ vöechny tyto Ë·sti, ale je
moûnÈ  je  volitelnÏ  doplÚovat.  Integrovanou  knihovnu  lze  mimo  klasickÈho  postupu  vytvo¯it  z existujÌcÌho
projektu  (Design ->  Make  Integrated  Library).  Tato  funkce  je  v˝hodn·  p¯edevöÌm  pro  vytvo¯enÌ  lehce
p¯enosnÈho  projektu.  Ten  pak,  mimo  schÈmat  n·vrhu  desky  ploönÈho  spoje,  zdrojov˝ch  text˘  programu,
obsahuje jedinou knihovnu, kter· v sobÏ sdruûuje vöechny pouûitÈ komponenty tohoto projektu.
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IntegrovanÈ knihovny vöak netvo¯Ì  jedin˝  typ knihoven v AD. Lze pouûÌt  samostatnÈ schematickÈ knihovny
(*.SchLib), knihovny pouzder (*.PcbLib) a knihovny model˘ (*.MDL,*.CKT), kterÈ p¯edstavujÌ jednotlivÈ souË·sti
integrovanÈ knihovny. Kaûd· dÌlËÌ knihovna pak obsahuje odkaz na jinou dÌlËÌ knihovnu obsahujÌcÌ nap¯Ìklad
odpovÌdajÌcÌ model pouzdra.

DalöÌm  typem  jsou  datab·zovÈ  knihovny,  kterÈ  umoûÚujÌ  centralizovanou  spr·vu  knihoven  (lze  i  u
integrovan˝ch knihoven prost¯ednictvÌm sdÌlenÈho prostoru na serveru). Komponenta v datab·zovÈ knihovnÏ
p¯edstavuje  odkaz na konkrÈtnÌ model komponenty uloûen˝ zpravidla na serveru.  Lze tak pohodlnÏ zmÏnit
nap¯Ìklad odkaz na prodejce, skladovÈ ËÌslo apod. nez·visle na vlastnÌm modelu komponenty. Tento zp˘sob
ulehËuje souËasnou pr·ci vÌce Ëlen˘ t˝mu na spoleËnÈm projektu.

AD je  dod·v·n  v souËasnÈ  dobÏ  s vÌce  neû  1000 integrovan˝mi  knihovnami,  kterÈ  obsahujÌ  ve  standardnÌ
instalaci p¯esnÏ 127 595 komponent. Knihovny jsou organizov·ny do adres·¯˘ podle v˝robc˘ komponent a
v nich jsou jednotlivÈ knihovny rozdÏleny podle cÌlovÈho pouûitÌ komponent (nap¯. CATV Amplifiers nebo RF
and IF Attenuators). V takto velkÈm poËtu komponent v knihovn·ch je vöak rozhodujÌcÌ p¯edevöÌm vyhled·v·nÌ.
AD umoûÚuje vyhled·v·nÌ podle regul·rnÌch v˝raz˘ libovolnÈho informaËnÌho pole komponenty jak v aktivnÏ
pouûit˝ch knihovn·ch v projektu, tak v celÈm adres·¯i knihoven. Tato moûnost do jistÈ mÌry umoûÚuje uûivateli
vyuûÌt i knihovny, kterÈ nezn· detailnÏ, jak tomu b˝v· p¯i zah·jenÌ pr·ce s nov˝m n·vrhov˝m systÈmem.

Knihovny jsou dostupnÈ i na str·nk·ch Altium Community Libraries. Na zÌsk·v·nÌ 3D model˘ komponent je pak
vhodn˝ port·l 3D ContentCentral.

4. Zdroje informacÌ

HlavnÌm zdrojem informacÌ p¯i pr·ci s Altium Designerem by mÏla b˝t vlastnÌ n·povÏda programu, kter·
je realizov·na dvojÌm zp˘sobem. PrvnÌ jsou lok·lnÌ dokumenty n·povÏdy (Local Documents) v podobÏ
PDF  a  dalöÌch  soubor˘  nahran˝ch  p¯i  instalaci  do  sloûky  Help,  pro  kterÈ  je  pouûito  fulltextovÈ

vyhled·v·nÌ.  Druh˝ zp˘sob n·povÏdy je zprost¯edkov·n pomocÌ  online  Wiki,  kter· je zobrazov·na p¯Ìmo v
prohlÌûeËi AD (wiki.altium.com).

Tento  systÈm n·povÏdy  je  doplnÏn  samostatn˝mi  trÈninkov˝mi  kurzy a  pr˘vodci,  video  manu·ly a
uk·zkami,  online  semin·¯i a  na  mÌru  organizovan˝mi  v˝ukov˝mi  kurzy (www.altium.com ñ
DEMOcenter, TRAININGcenter).  Mezi dalöÌ zdroje informacÌ a pomoci uûivatel˘m lze za¯adit ofici·lnÌ

centrum podpory  SUPPORTcenter (www.altium.com/supportcenter)  a  ofici·lnÌ  uûivatelskÈ fÛrum.  Oba tyto
zdroje jsou p¯ÌstupnÈ po p¯ihl·öenÌ uûivatele pomocÌ jeho Altium ˙Ëtu.

Z  lok·lnÌch zdroj˘ je moûnÈ kontaktovat CZ/SK zastoupenÌ spoleËnosti Altium Ltd. firmu  RETRY s.r.o.
nebo  takÈ  vyuûÌt  emailovou  konferenci  Altium  Designer na  konferenËnÌm  serveru  Pandora  ñ
altium@pandora.cz (pandora.idnes.cz/conference/altium).

Altium Designer ñ ZaËÌn·me   (5.12.2010) www.edatools.cz  |  10



5. Kontakt

5.1. Kontakt pro »R a SR

RETRY s.r.o. 
EDA tools and systems
K¯ivÈho 7
612 00 Brno
Czech Republic

I»O: 25324527 
DI»: CZ25324527

tel.: +420 549 210 082
fax.: +420 549 210 711
e-mail: info@edatools.cz
web: www.edatools.cz

5.2. Technick· podpora

tel.: +420 546 212 608 
fax.: +420 549 210 711
e-mail: support@edatools.cz

5.3. äkolenÌ

äkolenÌ  na  pouûitÌ  v˝vojovÈho  systÈmu Altium Designer  je  prov·dÏno  v  pravideln˝ch
intervalech  nebo  na  mÌru  poûadavk˘m  naöich  z·kaznÌk˘.  Pro  detaily  navötivte  naöe
str·nky www.edatools.cz nebo n·s kontaktujte na uvedenÈm emailu.
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Formul·¯ konverznÌ procedury

Krok SplnÏno Popis

Eagle: 2.1.1 Export schÈmatickÈho v˝kresu

1 Vöechny objekty v kladn˝ch sou¯adnicÌch.

2 OdstranÏnÌ nezapojen˝ch vodiË˘.

3 Kontrola konzistence dat s ploön˝m spojem.

4 SpuötÏnÌ skriptu Ñeagle2ad_sch.ulpì.

Eagle: 2.1.2 Export v˝kres˘ ploönÈho spoje

5 Vöechny objekty v kladn˝ch sou¯adnicÌch.

6 P¯Ìkaz SMASH pro vöechny objekty.

7 NastavenÌ p¯i¯azenÌ vrstev ve skriptu.

8 SpuötÏnÌ skriptu Ñexport-protelpcb.ulpì.

Altium: 2.2.1 NastavenÌ projektu

9 Vytvo¯enÌ PCB projektu.

10 P¯id·nÌ soubor˘ do projektu.

11 NastavenÌ glob·lnÌch jmen spoj˘.

12 ZruöenÌ vytv·¯enÌ Rooms.

13 UloûenÌ projektu.

Altium: 2.2.2 Import schÈmatick˝ch v˝kres˘

14 Kontrola ˙plnosti konverze dokumentu.

15 RuËnÌ doplnÏnÌ vöech polygon˘.

16 NastavenÌ pravidel pro vöechny polygony.

17 NastavenÌ obecn˝ch n·vrhov˝ch pravidel.

18 DalöÌ manu·lnÌ ˙pravy.

19 Design Rule Check.

Altium: 2.2.3 Import ploön˝ch spoj˘

20 Reset ID komponent.

21 Smaz·nÌ vöech logick˝ch propojenÌ el. spoj˘.

22 NastavenÌ Component Links.

23 Synchronizace dokument˘ Update/Import Changes.
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Krok SplnÏno Popis

Altium: 2.3.2 ⁄pravy knihoven - VOLITELNÃ

Altium: 2.3.3 UloûenÌ projektu

24 UloûenÌ projektu a vöech dokument˘.

Altium Designer ñ ZaËÌn·me   (5.12.2010) www.edatools.cz  |  13



All rights reserved. © 2010 Retry s.r.o.


